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Quick Start
So you want to get started in a hurry?  Follow "SoundWarrior" through the steps to 
MP3 Audio Mixer mastery!

1. Start MP3 Audio Mixer
SoundWarrior double clicks the MP3 Audio Mixer icon on his desktop.  Okay, we 
could have left this step out. �

2.  Drag in some sounds.
SoundWarrior has a good sound of a cave-woman scream called arghhh1.wav.  
The sound is located in "c:\cavescreams\", which he finds, and then drags the 
sound’s icon onto the MP3 Audio Mixer window.  See working with sounds. 

3.  Drag in some more sounds.
SoundWarrior also drags in stampede.wav, the sound of a herd of Mastodons 
stampeding by his cave.  Finally, he drags in an MP3 called "rockrolls.mp3", 
some of the latest music from "The Stoners"

4.  Make a recording if you want.
SoundWarrior hits the record button and the record dialog comes up.  He 
punches the record button on the dialog and screams into his microphone "You 
make fire now!  I make fire yesterday!"  He then hits the stop button, previews the 
sound and saves it as "me_talk1.wav".  See recording sounds. 

5. Save
SoundWarrior hits ctrl-S and a dialog box asks him to name the Sound Group.  
He calls it cavesound1.sgp.

6. Export As an MP3 file..
He wants to put it on cavenet.com so others can be jealous of his work of art.  He 
selects "Save As A…" from the "File" menu and then selects "MP3 file" which 
brings up a dialog.  He finds the best MP3 format for the job.  In this case, he 
selects "CD Quality" and hits the preview button.  The default MP3 player comes 
up and plays 5 seconds in the MP3 format.  He likes it and then hits the save 
button.  More on exporting …

7. Find a Mastodon to chase? ����
With all the time he saved, he can take the rest of the day off.  Maybe he’ll draw 



some paintings or even sharpen a stick.  



Overview
MP3 Audio Mixer is an intuitive multi-track sound recording and mixing utility.  

 Let your creativity take off…….!
It lets you record, overdub and mix multiple tracks of .wav and .mp3 files.  The 

simple, fast and intuitive interface makes it a no-brainer when it comes to 
sound mixing.  With support for the standard copy, cut, paste, undo and redo you 
can even make a few mistakes!  

Drag sounds in , record a few from the CD or microphone.  Change things in 
real-time while its playing.  Focus on your creativity, not technical details! 

MP3 Audio Mixer lets you edit 3 primary effects non-destructively!  It gives you 
the ability to edit and create "pivot points" for volume, pan, and playback rate.  For 
example, if you wanted to fade in a "coolness.wav", you could create a volume pivot 
point, set it to 0% volume, create another pivot point further down on the sound and 
drag it to 100% volume.  You can add as many pivot points as you want.  If that’ s 
not enough, you can also edit the sound or a copy of a sound in an external sound 
editor.

If you start to have a lot of sounds or a lot of tracks, you can make a Sound 
Group.  For example, you could group all of your "laughing" sounds into a single 
"laughing" Sound Group or "laugh track".  You can then drag that Sound Group 
around as if it was a single sound.  You can even shape the volume and pan for the 
entire group with its own non-destructive pivot points.  This can be extremely useful 
and time saving!  At later dates, you can even import other Sound Group Files (.sgp) 
into your session!

Once you have everything the way you like it, you can save it as an MP3,  
Wave , WMA or RealAudio file .  It lets you quickly preview the session in different 
RealAudio compression algorithms to find the one that works best.  You can even 
preview how it will sound 5 minutes into the session.  (Normally, this would require 
you to render the entire thing, which can be quite time consuming.)



Registration
Why Register? 
How do I Register? 
Enter your Registration Code(s) 

Why Register?
Registering will entitle you to the following benefits.

� Unlimited technical support
� MP3 Audio Mixer is fully functional
� Priority feature requests.  If there is something that you want MP3 Audio 

Mixer to do, just request it and it will most likely end up in a future release.  
We will take your input very seriously!

In addition, you will be supporting Acoustica and its mission to create high quality 
and intuitive software.  

OK, So you want to register.  How do you register?  
You can obtain your registration code(s) via the following ways…

� Internet Registration
Click any "Buy Now!" link in the software to activate the integrated 
purchase.  Alternatively, run your Internet web browser and go to 
http://www.acoustica.com/buy.htm .  All necessary instructions are on the 
web site.

� Old Style Mail Registration (Snail Mail)
Fill out register.doc in the MP3 Audio Mixer program group, print it out and 
send it to:

Acoustica
P.O. Box 728
Oakhurst, CA 93644
U.S.A.

Include a money order for $24.95.  If you are not in the United States, 
please make sure to include an international money order for $24.95 US 
dollars.  

[Make sure to add the following information.]



Your Name:
Email Address:  
(Please print clearly)

Product: MP3 To Wave Converter PLUS
(We have more than one software product!)

Mailing Address:
Phone Number:
(In case there is a problem with your email.)

Please don’ t forget to include your email and mailing address so that we 
can send you a registration code.  For other purchasing alternatives, 
visit http://www.acoustica.com/snailmail.htm

Upon payment, a registration code will be emailed or mailed to you.  

You have your registration code now!  How do you enter your registration 
code into MP3 Audio Mixer?

You will simply need to run MP3 Audio Mixer.  Click  "Enter Code" on the first screen 
that comes up and then enter your code and click the Register button.  Alternatively, 
you may select "Enter Registration Code" from the "Help" menu.  Enter the code you 
obtained and click the Register button.  

Now you are registered MP3 Audio Mixer owner!  Thank you very much!  
If you have any problems please visit our support page at 
http://www.acoustica.com/mp3-audio-mixer/support.htm 

-The Acoustica Team



Company Information
Acoustica was founded in 1998 and is located in the foothills of the Yosemite Valley.  
Acoustica's mission is to create high quality, intuitive and powerful software.  We 
value diligence, creativity and innovation.  We are embracing Internet technology and 
the new world that it is creating.  We also have this curious idea that SOFTWARE 
SHOULD BE EASY TO USE! �

MP3 Audio Mixer was the first in a series of highly innovational and user-friendly 
software we are making.  Our other products include MP3 To Wave Converter PLUS, 
MP3 CD Burner.and CD Label Maker.

Acoustica
P.O. Box 728
Oakhurst, CA 93644
U.S.A.
www.acoustica.com 

Copyright © 1998-2001 Acoustica.  All rights reserved.  No part of this manual may be 
copied, reproduced, translated or transmitted in any form by any means for any 
purpose without the express written permission of Acoustica.



Version History

MP3 Audio Mixer 2.47
� Added support for Esellerate purchasing system
� Added a "Enter Registration Code" menu item to Help.
� Bug fixes

MP3 Audio Mixer 2.42
� Export as WMA files
� Ability to load WMA files

MP3 Audio Mixer 2.13
� New trial period.  Trial is now 7 days.
� Track marker bad char save bug fixed
� Multi-MP3 save with marker drift bug fixed.
� Adding sound crash/freeze fixed.
� Can now import .cbs files as playlists.
� Re-adding copy of trimmed sound now showing full length
� Fix for bug when importing an old Sound Group into an existing Sound Group 

(embedded SoundGroup import) - Lengths were not showing up correctly. 
This would only affect a small portion of people.

MP3 Audio Mixer 1.5
� New name: MP3 Audio Mixer!
� Crop from left implemented
� Save As MP3
� Ability to play from previous or current timeline marker
� Easier to read timeline
� Zoom via the mouse wheel.
� Fixed MP3 looping bug
� Fixed other bugs.

Internet Audio Mix 1.4
� Improved MP3 syncing technology.
� Waveform visuals are cached for almost instantaneous loading after the 

initial load of a sound or MP3.
� Track markers to help organize your session and also for making special 

mixes for multi-track continuous audio cds.
� Keyboard nudging control to move sounds around.
� Import playlists (.m3u, .pls) to build very cool automatic segued sessions. 



� Save as multiple WAV file especially for creating a multi-track continuous 
audio cd.

� Many little odds and ends
� Many bug fixes.

Internet Audio Mix 1.32
� Better zoom in/out
� Bug fixes

Internet Audio Mix 1.3
� Support for RealNetwork’ s G2 protocol, including Surestream.
� Integrated MP3 support.
� Bug fixes

Internet Audio Mix 1.25
� Improved recording level display
� Better support for MP3.
� Lock/Unlock positions for sounds and Sound Groups.
� Undo/Redo support for locking, muting, and changing of names.
� Bug fixes

Internet Audio Mix 1.21
� Recording from the hard drive or RAM.
� Playback selections.
� Double click and add a sound at that time offset.
� Option to combine playback indicator and paste point (caret).
� Cancel button during wave file/RealAudio rendering.
� Bug fixes.

Internet Audio Mix 1.2
� Full duplex recording (overdubbing)
� Edit waveforms in an external sound editor.
� Copy, cut and paste portions of sounds or sound groups.  For example, this is 

very useful and fast if you want to only copy the word "cool" from a long 
passage.

� Render the whole session or just what sounds or Sound Groups you’ ve 
selected as RealAudio clip.  This is handy for listening to a portion of your mix 
in RealAudio.

� Support for importing and mixing MP3s if you have a MPEG Layer-3 codec for 
Window's Audio Compression Manager installed.  See website for more 
information on installing a MP3 codec.



� Supports multiple sound cards.  Select the sound card for playback and the 
one for recording



You can add as many extra pivot points as needed by clicking on the bar when the 

cursor changes to a pencil .  

Fig08a. Before adding a volume pivot point.

Fig08b. After adding a volume pivot point.

To change the current parameter (volume, pan, or rate), select from the drop down box 
on the right side of the toolbar. 

Fig09. Drop down box to select current effect.

In addition to moving individual points, you may also move the line that connects the 2 
adjacent points.  When the mouse is over the line, it will look like a vertical resize 
cursor.  You can simply press the mouse down and drag, which causes the 2 points to 
adjust their values.

To delete a pivot point, position your mouse over the point and right click.  Select 
Delete Point from the popup menu.



Limits of the pivot points.

• Volumes from 0% to 100%
• Pans from 100% Left Speaker to 100% Right Speaker
• Rates from 10% to 400% original speed.

Sound Information Dialog
Click the right mouse on a sound and select Sound Info from the pop-up menu.  A 
dialog will come up displaying the sound’ s name, file location, sound format, length 
and size.  You may change the sound’ s name by editing the name text box.

Fig09a.  Sound Information Dialog.

Compressed Sounds 
Any compressed sound files are loaded via Window’ s Audio Compression Manager 
and therefore a codec must be installed on your machine.  The Audio Compression 
Manager is standard on Win95/98/NT. 

Generally, any codec should work, but here is a list of tested codecs.

Microsoft IMA ADPMCM, Microsoft ADPCM, Microsoft GSM 6.10, Microsoft CCITT 
G.711 A-Law and u-Law

In addition to ACM support, the software will import WMA and MP3 files.  In order to 
load and save WMA files, you’ ll need to install support for WMA Format  7.1.





Working with Sound Groups
Sound Groups are useful collections of sounds.  By combining sounds into a Sound 
Group, the user has more master control over the way the sounds are mixed 
together.   You can think of a Sound Group as a composite sound.  Sound Groups are 
hierarchical and may be many layers deep, much like the file directory system on this 
computer.

Creating Sound Groups 
Moving a Sound Group 
Adding sounds to a Sound Group 
Collapsing and Expanding Sound Groups 
The Main Sound Group 
Loading Sound Group Files 
Adding Sound Group Files 
Playing, stopping and muting Sound Groups 
Adjusting a Sound Group’ s volume and pan 
Mix To A Single Sound 
Missing sounds 

Creating Sound Groups
Sound Groups are created by choosing NewGroup from the Sound Group menu. 
When the Sound Group is created you have the option of naming it.  The Sound Group
’ s name will default to "Untitled".  

Note that this same dialog can be invoked by selecting the Sound Group with the 
mouse and selecting Group Info from the Sound Group menu.

If sounds and other Sound Groups are selected, you will be able to Group From 
Selection, which simply creates a new Sound Group and adds all the selected sounds.



Fig10a. Creating a Sound Group from a selection of sounds.

Moving a Sound Group
A Sound Group may be moved in the same way that a sound is moved.  Simply 
position the mouse on the Sound Group’ s title bar, click the left mouse button and 
move the mouse.

Note that a Sound Group may not be resized by stretching the right side of the Sound 
Group.  However, a Sound Group may be resized by Expanding a Sound Group and 
moving the sounds within.



Adding sounds to a Sound Group
To add sounds into a Sound Group, simply select the sound or sounds and drag them 
over and into the destination Sound Group.  The sounds that you are changing will 
look more transparent when they are able to go into a Sound Group.

Fig11. Moving a Sound into a Sound Group.

In addition, you can also drag Sound Groups into other Sound Groups.  The Sound 
Group hierarchical system can be very useful for organization and Sound Group re-use.

Collapsing and Expanding Sound Groups
Initially, a Sound Group appears as a bar.  



Fig12.  Initial look of a Sound Group.

If you select the Sound Group, you may Expand it.  Expanding the Sound Group 
causes the main display to be replaced by the contents of the new Sound Group.  You 
can expand a group by selecting Expand from the Sound Group menu.  Expanded 
groups have a red diagonal striped background, which helps you know the extent of 
the Sound Group.



Fig13.  Expanded Sound Group

Once you have Expanded a Sound Group, you may also Collapse it, which simply 
replaces the screen contents with the parent Sound Group.   Collapse can be found on 
the Sound Group menu as well, as long as the user is viewing an expanded Sound 
Group.

The Main Sound Group
The Main or first Sound Group is special.  Although it doesn’ t appear as a bar, it is the 
main container for all sounds and sub Sound Groups.  When MP3 Audio Mixer loads, 
you start in the main Sound Group.  You cannot collapse the Main Sound Group.   

When the user selects Save from the File menu, they are actually saving the main 
Sound Group.  (See File : Save )

Loading Sound Groups 
Previously saved Main Sound Groups may be reloaded by selecting Open from the File
 menu, which brings up a standard file dialog.  Find the Sound Group file (.sgp) and 
select the "Open" button.  

Adding Sound Group Files
You may also add Sound Group files to MP3 Audio Mixer in the same way that you 
drag Wave sounds from the desktop.  Locate the Sound Group file(s) on the desktop 
and drag them into MP3 Audio Mixer.  The Sound Group and all sub sounds and sub 
Sound Groups will be automatically added!

Playing, stopping and muting a Sound Group
Sound Groups may be played in the same way that sounds are played.
See Also. 



The Main Sound Group may be played by selecting Play from the Sound Group menu 
or by pressing the Play button on the toolbar.

You may play a selection of the current group by first making a selection and then 
pressing the Play button.

Adjusting a Sound Groups volume and pan
Sound Groups may be adjusted in the same way that sounds are adjusted.  Note that 
the Sound Groups parameters affect all sub Sound Groups and sounds contained 
within.  (Note that playback rate is not an option for Sound Groups.)

Example
SoundWarrior has about 100 burps that make up this splendid audio delicacy.  He 
wants to make it sound like they are far away and to the left.  Instead of changing the 
volume and pan for every single burp, like he did last time, he decides to create a new 
Sound Group with the burps, called "Burp Group".  Then he simply lowers the volume 
and pans "Burp Group" to the left, and walla. 

Mix To A Single Sound
If the layers of sounds are too thick or maybe your computer’ s performance is slowing 
down, you have the option of mixing a Sound Group down to a single Wave file.  Just 
right click on a Sound Group and select "Mix To A Single Sound".  A dialog will pop up 
allowing you to select the destination sound format.  Preview how it will sound and 
when you’ re ready press the "Save" button.  Pick a new filename and it will convert the 
Sound Group into a single sound.  You can always undo this back to a Sound Group.  
The only item to note is that the sound that was created will remain on the hard drive.

Missing Sounds
Sometimes when loading a new Sound Group, MP3 Audio Mixer may not be able to 
find a sound.  The sound may have been moved to a different hard drive or folder.  Or 
you may have changed its name.  In that case, a dialog pops up and automatically 



searches for the sound.  If you know where the sound is you may select the Browse 
button to explicitly tell MP3 Audio Mixer to use a certain sound.  If you don’ t care about 
the sound, you may simply hit the Skip button.

Fig13a.  MP3 Audio Mixer is searching for a missing sound.



Export Options
You can export your mix to other formats.  

WAV 
WAV files are the most widely supported file types.  Unfortunately, these are also 
the largest file type.  This would be the best option if you are burning audio cds.  
More on exporting to WAV …

MP3 
MP3 files are the most popular way of encoding sound at this time.  This would be 
the best option if you are sending your MP3 files to the Internet, are creating an MP3 
data cd, or are sending them to a portable MP3 device.  More on exporting to MP3 …

Realaudio™ 
Realaudio files were the first highly compressed file format to hit the Internet.  
Choose this option if you wish to create a realaudio file for streaming over the 
Internet.  More on exporting to Realaudio …

WMA 
WMA files are Windows Media Audio files.  This would be the a smaller, more 
compact alternative to MP3 files.  It is not as widely supported as MP3 files are but, 
since this is the Microsoft format, it has a funny way of becoming more popular every 
day. �  More on exporting to WMA …



Exporting To WAV
Destination File Size 
Render All/Selection 
Sampling Rate 
8 or 16 bits 
Stereo 
Title, Author, Copyright 
Create separate WAV file for each CD Marker? 

From the "File" menu, select "Save As a" and then select "Wave File" from the 
submenu.  Pick a name for your new WAV file. ( If you are going to be saving 
multiple WAV files for each CD Track Marker, this name will be the base name. )

After a name or base name is chosen, you need to set up extra parameters for the 
WAV file.   Once all the settings are made, click the Save button to render the 
session to a WAV file.  After it is finished, it will play the sound back via your default 
WAV player.

Destination File Size
This is a helpful indicator that estimates how big the destination file size is going to 
be.  

Render All/Selection
The default is to render the entire session.  However, you can also render the current 
selection.  You might choose to render the selection if you want to hear how it 
sounds under a certain sample rate, bits and stereo combination.  (You wouldn’ t 
have to render the entire session which could take a while depending on the length 
of the session.)

Sampling Rate
The sampling rate is the number of samples of audio for every second.  Note that 
the highest frequency will be half of the sampling rate.   Higher sampling rates will 
mean higher frequency response.  The converse is that file size is also increased 
when higher sampling rates are used.

8 bit or 16 bits
The number of bits is the amount of data used to store 1 sample.  16 bit samples will 
be higher in quality with less noise artifacts.  8 bit sounds are noisier but will also be 
half the size!  If you don’ t know which to choose, set it to 16 bits.

Stereo



Check this if you want to create a stereo WAV file.  If this is unchecked, the resultant 
WAV file will be mono (one channel of audio.)

Title
This should be the title of the recording.  Note that this is not the same as the 
filename.  The title information is not read by that many programs, though.

Author
This should be the name of the person or organization that made the recording.  
(This will be automatically filled in if you filled this info in the Preferences.)

Copyright
This should be the copyright for the recording.  (This will be automatically filled in if 
you filled this info in the Preferences.)

Create separate WAV file for each CD Marker?
This option will be enabled if you have more than 1 CD Track Marker.  If you select 
this option, MP3 Audio Mixer will create a WAV file for each section of audio.  More 
on track markers …



Exporting To MP3
Encoder Engine 
Destination File Size 
Render All/Selection 
Preset Quality 
Specify Exact Settings 
Entering File Information 
Create Separate MP3 File For Each CD Marker? 

From the "File" menu, select "Save As a" and then select "MP3 File…" from the 
submenu.  Pick a name for your new MP3 file. ( If you are going to be saving 
multiple MP3 files for each CD Track Marker, this name will be the base name. )

After a name or base name is chosen, you need to set up extra parameters for the 
MP3 file.   Once all the settings are made, click the Save button to render the 
session to an MP3 file.  After it is finished, it will play the sound back via your default 
MP3 player.

Encoder Engine
The Encoder Engine is what actually creates the MP3 file.  MP3 Audio Mixer sends 
the audio data to the encoder engine and it creates the MP3 data which is then 
saved to a file.   The L.A.M.E. engine is the default MP3 encoder.  More info on MP3 
Encoder Engines …

Destination File Size
This is a helpful indicator that estimates how big the destination file size is going to 
be.  It is an approximation, though, especially when rendering to variable bit rate 
MP3 files which depend on the actual audio content.

Render All/Selection
The default is to render the entire session.  However, you can also render the 
current selection.  You might choose to render the selection if you want to hear how 
it sounds under a certain compression.  (You wouldn’ t have to render the entire 
session which could take a while depending on the length of the session.)
  
Preset Quality
Adjust the slider and choose one of the presets to set the desired MP3 quality.  More 
info on presets …

Specify Exact Settings
You can also set the exact format to encode to.  For example, if you want to create a 



variable bit rate MP3, you’ ll need to use this option.  More on setting the specific 
encoding settings …

Entering File Information
MP3 Audio Mixer adds authoring information to the MP3 file.  It creates an ID3V1 
and ID3V2 tag by default.  You can fill in the Title, Author, Copyright, Genre, Year 
and Comment.

Create Separate MP3 File For Each CD Marker?
This option will be enabled if you have more than 1 CD Track Marker.  If you select 
this option, MP3 Audio Mixer will create an MP3  file for each section of audio.  More 
on track markers …



Exporting To WAV
Destination File Size 
Render All/Selection 
Sampling Rate 
8 or 16 bits 
Stereo 
Title, Author, Copyright 
Create separate WAV file for each CD Marker? 

From the "File" menu, select "Save As a" and then select "Wave File" from the 
submenu.  Pick a name for your new WAV file. ( If you are going to be saving 
multiple WAV files for each CD Track Marker, this name will be the base name. )

After a name or base name is chosen, you need to set up extra parameters for the 
WAV file.   Once all the settings are made, click the Save button to render the 
session to a WAV file.  After it is finished, it will play the sound back via your default 
WAV player.

Destination File Size
This is a helpful indicator that estimates how big the destination file size is going to 
be.  

Render All/Selection
The default is to render the entire session.  However, you can also render the current 
selection.  You might choose to render the selection if you want to hear how it 
sounds under a certain sample rate, bits and stereo combination.  (You wouldn’ t 
have to render the entire session which could take a while depending on the length 
of the session.)

Sampling Rate
The sampling rate is the number of samples of audio for every second.  Note that 
the highest frequency will be half of the sampling rate.   Higher sampling rates will 
mean higher frequency response.  The converse is that file size is also increased 
when higher sampling rates are used.

8 bit or 16 bits
The number of bits is the amount of data used to store 1 sample.  16 bit samples will 
be higher in quality with less noise artifacts.  8 bit sounds are noisier but will also be 
half the size!  If you don’ t know which to choose, set it to 16 bits.

Stereo



Check this if you want to create a stereo WAV file.  If this is unchecked, the resultant 
WAV file will be mono (one channel of audio.)

Title
This should be the title of the recording.  Note that this is not the same as the 
filename.  The title information is not read by that many programs, though.

Author
This should be the name of the person or organization that made the recording.  
(This will be automatically filled in if you filled this info in the Preferences.)

Copyright
This should be the copyright for the recording.  (This will be automatically filled in if 
you filled this info in the Preferences.)

Create separate WAV file for each CD Marker?
This option will be enabled if you have more than 1 CD Track Marker.  If you select 
this option, MP3 Audio Mixer will create a WAV file for each section of audio.  More 
on track markers …



Exporting To MP3
Encoder Engine 
Destination File Size 
Render All/Selection 
Preset Quality 
Specify Exact Settings 
Entering File Information 
Create Separate MP3 File For Each CD Marker? 

From the "File" menu, select "Save As a" and then select "MP3 File…" from the 
submenu.  Pick a name for your new MP3 file. ( If you are going to be saving 
multiple MP3 files for each CD Track Marker, this name will be the base name. )

After a name or base name is chosen, you need to set up extra parameters for the 
MP3 file.   Once all the settings are made, click the Save button to render the 
session to an MP3 file.  After it is finished, it will play the sound back via your default 
MP3 player.

Encoder Engine
The Encoder Engine is what actually creates the MP3 file.  MP3 Audio Mixer sends 
the audio data to the encoder engine and it creates the MP3 data which is then 
saved to a file.   The L.A.M.E. engine is the default MP3 encoder.  More info on MP3 
Encoder Engines …

Destination File Size
This is a helpful indicator that estimates how big the destination file size is going to 
be.  It is an approximation, though, especially when rendering to variable bit rate 
MP3 files which depend on the actual audio content.

Render All/Selection
The default is to render the entire session.  However, you can also render the 
current selection.  You might choose to render the selection if you want to hear how 
it sounds under a certain compression.  (You wouldn’ t have to render the entire 
session which could take a while depending on the length of the session.)
  
Preset Quality
Adjust the slider and choose one of the presets to set the desired MP3 quality.  More 
info on presets …

Specify Exact Settings
You can also set the exact format to encode to.  For example, if you want to create a 



variable bit rate MP3, you’ ll need to use this option.  More on setting the specific 
encoding settings …

Entering File Information
MP3 Audio Mixer adds authoring information to the MP3 file.  It creates an ID3V1 
and ID3V2 tag by default.  You can fill in the Title, Author, Copyright, Genre, Year 
and Comment.

Create Separate MP3 File For Each CD Marker?
This option will be enabled if you have more than 1 CD Track Marker.  If you select 
this option, MP3 Audio Mixer will create an MP3  file for each section of audio.  More 
on track markers …



Exporting to RealAudio™
What is RealAudio™ ? 
Exporting to RealAudio™ 
Creating the RealAudio File (.ra) 
Optimizing your sound for RealAudio™. 
Uploading it to the Internet. 

*Important to version 1.5+ : If you can not create Realaudio files, then you must 
download and install the optional Realaudio plugin from Acoustica @ 
http://www.acoustica.com/download.htm 

What is RealAudio™ ?
RealAudio is an audio format, which is highly compressed and small, allowing for real 
time streaming of audio over the Internet.  RealAudio is a proprietary technology 
owned by RealNetworks, Inc.  The latest version of RealAudio is called G2.  Its main 
feature is called SureStream, which allows for multi-rate RealAudio files.

Exporting to RealAudio™.
One of the convenient features of MP3 Audio Mixer is the ability to instantly render the 
session into a RealAudio file. Simply select Save As.. from the File menu and change 
the file type to RealAudio™.   Select a filename and select the Save button.  This 
brings up the following dialog… There are several factors to consider.

SureStream vs. Single Rate 
Target Audience 
Content Type 
Render All or Selection 
Clip Information 



Fig17a.  Exporting to the Internet.

� SureStream vs. Single Rate
SureStream is RealNetwork’ s multi-format file.  It’ s the most important 
feature of G2.  You can create a SureStream file that will work with people 



connecting through a LAN, in addition to people with bit-pushin’  28.8 
modems!   The people with the higher speed connection will be served 
higher quality audio, while the people with the lower speed connection will be 
served the "less than perfect" audio.  You can have up to six target 
audiences.

What’ s the catch?  You need a RealServer G2 for playback!   (Your ISP may 
have a RealServerG2 already setup.)

• Pressing ‘Preview’  will automatically render the first 5 seconds of the 
session with the selected codec .

• Pressing ‘Fine Tune ’  will bring another dialog, which allows you to 
fine-tune the selected codec in case the preset codecs don’ t sound 
good.

• Selecting the "Create RealPlayer 5 Compatible Clip" will allow the 
older RealPlayer 5.0 players to play the clip.  It will make the clip 
slightly larger.

Single rate files can also be created.  These files can also be streamed via a 
traditional web server, just as if you were downloading a file. 

• Pressing ‘Preview’  will automatically render the first 5 seconds of the 
session of the current codec.

• Pressing Fine Tune will bring another dialog, which allows you to 
fine-tune the current codec in case the preset codecs don’ t sound 
good.

� Target Audience
Who is the target audience?  Perhaps, you have a lot of corporate visitors 
with LANs, but you also have 56K modem users.  You might select 2 target 



audiences (56K Modem and Corporate LAN).  

You can select up to 6 different target audiences if you are creating a 
SureStream.  If you are creating a single rate file, you can only select one 
target audience at a time.

� Content Type
This one is pretty self-explanatory.  Is your masterpiece music or voice?  Or 
is it voice with background music?  If the stereo separation is an important 
part of the piece, you might select "Stereo Music".  The most important test 
is to simply listen to how it sounds in the various settings.  The preview 
feature makes it very easy to do this.  Take advantage of it.

If you are going to eventually include this with a RealSlideshow™ or a 
RealVideo™, you should uncheck the "Audio Only?" checkbox which will 
adjust any selected codecs.  (It will lower the bit-rates to accommodate other 
data being downloaded.)

� Render All or Selection
One of the cool features of MP3 Audio Mixer is that you can render 
selections anywhere in your session.  Select some sounds and press the 
RealAudio button.   Now you can press the "Render Selection" radio button, 
which will enable you to render the current selection!  This can be very 
handy if you are curious how a particular segment sounds, but you don’ t 
want to render the entire 1 hour piece!

� Clip Information
This is the information that is stored with the clip.  The name of the clip will 



default to the name of the main Sound Group.  The copyright and author 
information will default from the Miscellaneous information tab in the 
Preference dialog.

Fig17b.  RealAudio Fine Tune Dialog

If you choose to fine-tune a codec, it will bring up this dialog (fig17b).  You may choose 
a different codec and preview it.  The bit-rate, frequency response, compatibility 
information and a detailed description are displayed as you switch between different 
codecs.  It will not allow you to exceed the maximum bit-rate for the target audience 
you are tuning.



Note: It may take awhile for the RealAudio file to be completely rendered, depending 
on the power of your computer and the length of the session.  You may hit the cancel 
button to escape a lengthy encoding.

Creating the RealAudio File (.ra)
After you are happy with the settings, you should press the Save button on the main 
RealAudio dialog.  Pick a filename and press "Save".  It may take awhile for the 
RealAudio file to be completely rendered, depending on the power of your computer 
and the length of the session.  You may hit the cancel button to escape a lengthy 
encoding.  By default, after it is finished encoding, it will play the newly rendered file.

Optimizing your sound for RealAudio™
You may be wondering, "how can I improve the way that my RealAudio files sound?"  
The rule of thumb is to not make your Sound Groups too quiet. If you feel they are too 
loud, simply turn your speakers down.  You will notice substantial improvements if the 
volume levels are kept as high as possible. 

If you have an external editor that can "compress" the sound, this may also help for 
RealAudio conversion.  This is not the file type compression.  This is referring to 
dynamic amplitude compression.  Basically it takes the low parts of your sound and 
makes them louder, as well as taking the loud parts and making them quieter.

Uploading it to the Internet.
MP3 Audio Mixer does not upload or publish the file to the Internet by itself.  You will 
find that most WEB page creation programs have this type of feature built in.  You 
may also choose to use a ftp program to upload the RealAudio file.  



Check the "Links" page on Acoustica for some links to sites that have useful 
information on uploading RealAudio files!



Export As WMA
If you do not see a WMA tab, you may not have WMA support properly installed.  

Destination File Size 
Render All/Selection 
Preset Quality 
Entering File Information 
Create Separate WMA File For Each CD Marker? 

WMA is a second-generation compressed audio format. 

From the "File" menu, select "Save As a" and then select "WMA File…" from the 
submenu.  Pick a name for your new WMA file. ( If you are going to be saving 
multiple MP3 files for each CD Track Marker, this name will be the base name. )

After a name or base name is chosen, you need to set up extra parameters for the 
MP3 file.   Once all the settings are made, click the Save button to render the 
session to an WMA file.  After it is finished, it will play the sound back via your 
default WMA player.

Destination File Size
This is a helpful indicator that estimates how big the destination file size is going to 
be. 

Render All/Selection
The default is to render the entire session.  However, you can also render the 
current selection.  You might choose to render the selection if you want to hear how 
it sounds under a certain compression.  (You wouldn’ t have to render the entire 
session which could take a while depending on the length of the session.)
  
Preset Quality
Adjust the slider and choose one of the presets to set the desired MP3 quality.  

The possible settings are:

Preset Bit rate Mode Frequency Response
===== ====== ===== ==================
1 16 kbps Mono 8,000 Hz
2 32 kbps Stereo 22,050 Hz
3 48 kbps Mono 44,100 Hz



4 64 kbps Stereo 44,100 Hz
5 96 kbps Stereo 44,100 Hz
6 128 kbps Stereo 44,100 Hz  (default)
7 192 kbps Stereo 44,100 Hz

Entering File Information
MP3 Audio Mixer adds authoring information to the WMA file.  You can fill in the 
Title, Author, Copyright, Genre, Year and Comment.

Create Separate WMA File For Each CD Marker?
This option will be enabled if you have more than 1 CD Track Marker.  If you select 
this option, MP3 Audio Mixer will create a WMA file for each section of audio.  More 
on track markers …



Preference Dialog
Playback Tab 
Recording Tab 
Miscellaneous Tab 
Information Tab 

Playback Tab
The Playback tab allows you to choose the quality at which your session plays.  

If you have more than one soundcard, you can choose the soundcard you want for 
playback in the Playback device drop down at the top of window.

If you select Use Best Quality, MP3 Audio Mixer will always use the best sound format 
in the session as the default sound format.  Choosing this option will ensure that you 
don’ t have any sound degradation.  

You may, instead, choose to use a specific format.  Wave formats have the following 
characteristics:

• Sample Rate
Sample rate simply means the number of times per second that the computer 
plays or records a snapshot of the sound.  Faster sample rates catch faster 
frequencies.  You may set the format to the following sample rates : 11,025 , 
22,050, and 44,100.

• Bits Per Sample
This determines the quality of each snapshot.  The more bits, the better.  You 
may set the format to either 8 or 16.  (8 has a tendency to sound fuzzy)

• Number of channels
Is it stereo or mono?  Setting the format to mono, will essentially disable 
panning.

The advanced section allows you to change the number of buffers and buffer size.  
Without getting too complicated, you use these options to find a balance between 
audio discontinuity and playback latency.

Latency is the amount of time it takes from the time you press the Play to the time you 
hear the sound.  If you feel the latency is to big, try reducing the number of buffers or 
the buffer size.

Audio discontinuity is sometimes described as "popping" or "static".  The audio will 
drop in and out.  If you have audio discontinuity problems, try increasing the number of 
buffers and/or the buffer size.

Recording Tab



Choose a Recording Device from the dropdown box if you have more than one 
soundcard!

This tab also has a full duplex test.  It lets you know if your soundcard supports full 
duplex, which is the ability to play sound and record at the same time.  Press the 
"Test" button to see how your soundcard fares.

The advanced tab is similar to the advanced tab for playback.  Here, you get to select 
the number of buffers and the buffer size set-aside for recording.  If you find that your 
recordings are missing sound or have static glitches, try increasing the number of 
buffers and/or the buffer size.   

You may also select the temporary recording directory.  Simply type in the path to the 
directory.  For example, say you have 5 GB of space on drive E:.  Simply, type "E:\" 
and press the "OK" button.  If you want to record using your computer’ s RAM, clear all 
characters from the edit box so that it is empty.  You should see "(RAM)" displayed 
above and then hit "OK".

Miscellaneous Tab

� Auto scroll during playback.
Normally, during playback if the indicator gets near the right end of the 
window, the view is scrolled over in time.  This option allows you to turn that 
off or back on.

� Start playback at beginning when near end.
Normally, if the session has played to the end, starting playback again will 
also cause the session to rewind to the beginning.  This option allows you to 
toggle the behavior.

� Wave Display Resolution
MP3 Audio Mixer can operate faster because it doesn’ t load in a pixel for 
every sound sample.  It defaults to 20 milliseconds per pixel.  You can now 
configure it to be anywhere from 1 millisecond per pixel to 100 milliseconds 
per pixel.

� Setting the playback indicator when clicking in the session window.
If you click within the main window, this will cause the playback indicator to 
be set.  Normally, this only sets the caret (paste point).  If you are currently 
playing, it will restart playback from this position.

� Play exported files after being created.
After exporting a new file, this will automatically play back your freshly 
created sound.  Thus, you can preview it to make sure it sounds correct.



� Editing sounds in an external editor.
If you want to edit sounds in an external editor, you need to select an 
external editor executable that MP3 Audio Mixer launches.  You can either 
type in the full path to the sound editor or press the Browse button to find it 
through Windows file system.

Information Tab
The name, and copyright fields will automatically appear when rendering the session 
to a RealAudio™ MP3, WMA or Wave file.  This saves you the trouble of having to 
type it every time you want to export or render a file.



Toolbar
The toolbar allows quick access to common functions.

   Create a new Main Sound Group.

   Open/Load a Main Sound Group.

   Save the Main Sound Group.

     Add a sound to the Main Sound Group.

   Play/Stop the Main Sound Group.

   Rewind to the beginning of the Main Sound Group.

   Fast Forward to the end of the Main Sound Group.

     Record a new sound from the CD, line-in or microphone.

   Zoom In.

   Zoom Out.

   Collapse the current Sound Group.

   Expand the selected Sound Group.

     Previews the sound as RealAudio®.

   Allows you to change the current effect displayed on the Sounds and 
Sound Groups.



File Menu
New 
Open 
Add Sound 
Import Playlist… 
Save 
Save As.. 
Save As A..WAV, MP3, WMA or Realaudio file
Preferences 
Exit 
 

New
This menu item clears the Main Sound Group.  If the current Main Sound Group is 
dirty, it will first ask if you want to save, before clearing.

Open
This menu item brings up a standard file dialog, which allows you to find a Sound 
Group file (.sgp) to load as the Main Sound Group.  If the current Main Sound Group is 
dirty, it will first ask if you want to save, before loading. 

Add Sound
This option allows you to add Wave files or Sound Groups to the current Sound Group.

Import Playlist…
This new feature allows you to import playlists (.m3u and .pls).  Playlists are simply 
lists of sounds (MP3s, usually.)  

After selecting a playlist to import, the PlayList Wizard dialog will come up.  Choose 
which sounds/MP3s to import.  You can set how much overlap there is between the 
sounds.  Or you can set it up to have space between the sounds.  You can also set the 
fade time. (Fade in and fade out.)  It will also create automatic CD Markers at the start 
of each new sound, if you select the option.  Finally click the "OK" button.  It will import 
each sound and generate a session.  This can be a very handy feature if you are a dj 
and you have some existing playlists.



Fig 18. Shows Import Playlist Wizard.

Save
This menu item saves the Main Sound Group as a Sound Group file (.sgp ).  If the 
Main Sound Group has not been saved yet, it will bring up a standard file dialog 
allowing the user to pick a filename and folder.

Save As…
This menu item allows the user to save the Main Sound Group with a different name. 

Currently, you may save it as one the following…

Sound Group 
Wave File 
MP3 File 
RealAudio™ File. 
WMA File 

You may elect to use this option if you are branching off in several possible sound 
designs and want to be able to compare them. 
 

Exit
There’ s always a time when you have to turn it off.  You can’ t use MP3 Audio Mixer all 
the time.  (We don’ t mind that much, though. ;-) )  

This exits MP3 Audio Mixer.  It will ask if you want to save, if the Main Group needs to 



be saved.



Edit Menu
Undo 
Redo 
Copy 
Cut 
Paste 
Select All 
Zoom In 
Zoom Out 

Undo
Undo allows you to go back to previous states.  Undo is supported for the following 
actions.

� Adding a sound or sounds to MP3 Audio Mixer.
� Cutting a sound or sounds.
� Moving a sound or sounds.
� Resizing a sound.
� Adding a volume, pan or rate pivot point.
� Changing a volume, pan or rate pivot point.
� Deleting a volume, pan or rate pivot point.

Once you save, the Undo memory is cleared. (Thus, you cannot Undo after saving…)

Redo
Redo is the opposite or Undo.  For example, Sound Warrior adds a pivot point on his 
"heartywarcry.wav", then decides he doesn’ t like it and does an Undo.  Suddenly, he 
thinks of the ancestors looking down upon him and decides to put it back by doing a 
Redo.

Copy
Copy will take a snapshot of all currently selected sounds and Sound Groups.  Each 
successive Copy command clears the previous copied sounds and Sound Groups.   
Note that this will copy only the selected portions of sounds and Sound Groups.

Cut
Cut will remove all currently selected portions of sounds and Sound Groups from MP3 
Audio Mixer.  It will also copy the selected portions of sounds into the clipboard for 
pasting.  (Don’ t worry, remember, you can Undo.)

An alternative to Cut, is the ‘Delete’  key.  This will cut all the selected portions of 
sounds, but will not store them in the clipboard.  This is handy if you don’ t want to 
overwrite the contents of the clipboard. (This was a registered users requested feature)



Paste
Paste will add all Copied sounds and Sound Groups to MP3 Audio Mixer at the Caret 
position.

Select All
All sounds and Sound Groups in the current Sound Group will be selected.

Zoom In
MP3 Audio Mixer allows you to zoom in up to a resolution of 1 pixel = 4 millisecond.

Zoom Out
MP3 Audio Mixer allows you to zoom in up to a resolution of 1 pixel = 2 minutes.



Sound Group Menu
In addition to the menu bar, you can right click in the main session to get this menu.

Add Sound… 
Record Sound… 
New Group/Group From Selection 
Send To Parent Group 
Group Info 
Collapse 
Expand 
Play/Stop 
Rewind 
Fast Forward 

Add Sound…
This option brings up a standard file dialog allowing you to select a new Wave file 
(.wav) to include in the current Sound Group.  It will appear at the current position of 
the Caret.

New Group/Group From Selection
If sounds and/or Sound Groups are selected, the "Group From Selection" menu option 
will be active.  This will create a new Sound Group and then add all the sounds and/or 
Sound Groups currently selected.  The New Group option will appear if there isn’ t 
anything selected.  Both New Group and Group From Selection will then bring up the 
Group Info dialog allowing you to give it a good name, instead of "Untitled-X".

Send To Parent Group
This sends the currently selected sound or Sound Group to the parent Sound Group.

Group Info
Group Info is a dialog that allows you to change the name and associated comments.  
It also displays the date the Sound Group was created, its length in time, the number 
of sub-sounds and sub-Sound Groups.

Collapse
Collapse allows you view the parent Sound Group as the active Sound Group.  It 
"collapses" the currently "expanded" Sound Group.

Expand
Expanding a Sound Group causes it to become the active Sound Group.  You will see 
its sub-sounds and sub-Sound Groups in the main window.

Play/Stop
This option plays or stops the Main Sound Group.



Rewind
This causes playback to rewind to the beginning of the Main Sound Group.  This can 
happen during playback.

Fast Forward
This causes playback to fast forward to the end of the Main Sound Group.  You may 
use this option to get to the end of the Main Sound Group quickly.



Sound Menu
You can also use the Sound menu by right clicking on a sound bar.  Make sure that the 
sound is selected first.

Cut 
Copy 
Invert Map 
Reset Map 
Sound Info 
Send to Parent Group 
Muted 
Play/Stop 
Locked 
Edit In External Sound Editor 

Cut

This will remove the sound from the main window.  (You can always redo to get it 
back.)

Copy

This will copy the sound and it’ s associated pivot points for volume, pan and rate into 
memory.

Invert Map

This is a helpful function, which changes each pivot point to an opposite or mirrored 
value.  (This can be undone, as well.)

� Volumes of 100% will go to 0%.  Volumes of 50% will stay the same.  Volumes 
at 33% will go to 66%, etc.

� Pans of 100% left will go to 100% right.  Pans of 0% will stay the same.  Pans of 
30% will go to 70%, etc.

� Rates of 50% will go to 200%.  Rates of 100% will stay the same, etc.

Reset Map

Have you added a billion pivot points to "godly.wav"?  Don’ t want to undo everything 
else that you like, but you want to get this sound back to normal.  Simply select this 
Reset Map and it will be set back to the very original settings.  This works for each 
effect type separately, so you don’ t have to cleanse the volume, if you’ ve been 



mucking around with the rate. 

For volume, you will return to a sound or Sound Group with 2 pivot points, one at the 
start and, one at the end.  Both will be at 100% volume.

For pan , you will return to a sound or Sound Group with 2 pivot points, one at the start 
and, one at the end.  Both will be at 0% Pan (Centered between the speakers).

Sound Info

This brings up a dialog with information about the sound.

Send to Parent Group

This sends the selected sound to the parent group.  The sound will maintain its current 
time offset.

Muted

This either sets the sound to be muted or un-mutes the sound.  A check mark on the 
menu item indicates that it is muted.

Locked

This is a flag which tells you if the sound is locked in position.  If it has a check box 
next to it, it means that the sound bar is locked and cannot be moved.  To reposition a 
locked sound, un-toggle this option.

Play/Stop

This will play the sound if its not playing and stop it when it is.  



Troubleshooting
It’ s not making any sound 
Playback is stopping too soon! 
I can't load or save WMA files! 
Sound is breaking up 
How do I record from the CD? 
I can’ t preview RealAudio™ files 
MP3 Audio Mixer won't load the sound. It says that the format is unsupported 
I edited a sound in an editor and it messed up other sounds! 
How do I set MP3 Audio Mixer up to record from memory (RAM)? 
I’ m not hearing real-time changes of effects during playback! 
I can’ t render to RealAudio.  It says I need to download more files! 
How do I overdub or record while listening to my other tracks? 
New Tracks are picking up sound from old tracks 
Recording is not working! 
What are these CD Track Marker things? 
How do I cut and paste portions of sounds? 
I can't render to Realaudio™ files!  It's grayed out! 
Hey, I can’ t even find my problem in this section! 

It’s not making any sound
You’ ve added sounds, but you can’ t play anything...  There are a few things you can 
check here.

1. Are the speakers on and plugged in?  (Sorry, management made us ask.)
2. Can you play a Wave file through Windows sndrec32.exe or other sound 

application?   If you can't there may be a problem with your sound card's 
configuration or drivers.  Refer to your soundcard documentation to try to figure 
out what is wrong.

3. Load the volume control that came with your soundcard and make sure that the 
Wave device is turned up.

4. Another program may be using the Wave device.  MP3 Audio Mixer will put up a 
dialog stating that another application has the Wave device in this case.

Playback is stopping too soon!
If you are trying to play sounds in MP3 Audio Mixer and it seems to cut off too soon 
or it may have some other strange behavior, you should make sure that you have 
the latest drivers for your sound card.  Download the latest drivers from their 
website! 



I can’t load or save WMA files!
In order to load and save to WMA files, you must have support for Microsoft 
Windows Media Format 7.1.  If you are trying to load a WMA file or export to WMA 
file and the option is grayed out, you probably do not have this installed.  To 
download and install it, please visit http://www.acoustica.com/plugins/wma-install.htm
 .  (You do not need to restart your computer!)

Sound is breaking up
When playing the session, it sounds like someone is starting and stopping the sound 
real quick, repeatedly. This could be because the computer has slowed down due to 
other programs running at the same time. 

MP3 Audio Mixer has to work harder as the layers of sound increase. Try increasing 
the buffer size or the number of buffers in the Advanced Section of the Preferences 
Playback tab.

If you are doing a lot of recording and you find that the actual recordings are being 
broken up, you may change the Recording Settings on the Recording tab of the 
Preference Dialog.

I can’t preview or play RealAudio™ files
In order to hear RealAudio files, you must have the RealAudio player.  Download the 
latest player from http://www.real.com 

MP3 Audio Mixer won’t load the sound. It says that the format is unsupported
There are many different types of sound file formats.  MP3 Audio Mixer currently 
supports the Wave (.wav) format.  Trying to load a .aif or .au will not work.  
In addition, MP3 Audio Mixer will work with Windows Audio Compression Manager 
(ACM) to load compressed wave files.   If it is a WMA file, make sure that WMA 
format support is installed. 

I edited a sound in an editor and it messed up other sounds!
If you had copied a sound and then edited it in an external editor in the "Edit 
Original" mode, it would have made the copies reference the same sound file.  If the 
length was changed or if the sound were altered in a time specific way, MP3 Audio 
Mixer would not have been able to load it back in the correct way.  Next time 
consider selecting the "Edit A Copy" option.

How do I record from the CD?
MP3 Audio Mixer supports the recording of whatever sound that it is possible to 
record via your soundcard.  Here are the steps to record your CD.
Recording from the CD is simple as long as your soundcard is connected to your 
CD. 



1) Click on the speaker icon on the lower right hand corner of the window's desktop. 
If you do not have this, then you may need to add/remove programs and make sure 
you select all "multimedia" components.
         This should have brought up a window that is titled "Volume Control".
2) Select "Properties" from the "Option" menu.
         This brings up another window
3) Select the "Recording" option from the "Adjust Volume For" grouping.
         Look at the list box called "Show the volume controls."
4) Make sure that the "CD Audio" option is selected.
5) Hit OK
          Brings up the "Recording Control" window.
6) Make sure that "CD Audio" option is selected and at a decent level. 
7) Put in an audio CD and start it playing.
8) Launch MP3 Audio Mixer
9) Select the Record option and make sure the "Show Recording Level" is selected.
          You should see the level indicator moving in MP3 Audio Mixer's recording 
level.
          Go back to the Recording Control window if it’ s distorting.
10) Hit the record button in the MP3 Audio Mixer Record window and you are done.

 How do I set MP3 Audio Mixer up to record from memory (RAM)?
Go to the preference dialog and remove all text in the edit box labeled "Temporary 
Recording Directory".  You should see the words "(RAM)" appear.  Then click "OK" 
and record to your heart’ s content.  

I’m not hearing real-time changes of effects during playback!
If you have some sounds selected, you will not hear your volume, pan, rate or 
clipboard changes during playback.   However, if you restart playback after making a 
change, you will hear the changes.  

How do I overdub or record while listening to my other tracks?
You need to make sure that you have done the full duplex test and have the 
"Overdub" checkbox checked on the recording dialog.  Depending on your soundcard
’ s level of full-duplex support, you may need to set the recording sampling rate to be 
the same as the playback sampling rate.

I can’t render to RealAudio.  It says I need to download more files!
Not everyone uses MP3 Audio Mixer to create RealAudio files.  We chose to leave 
out the RealAudio files and make it an optional download.  This makes the download 
much smaller.  If you see a window that says that you are missing these files, you 
have two options.  You can either download and run the patch from Acoustica or 
download/install a RealNetwork’ s encoding program such as RealProducer™ or 



RealSlideshow™.  After installing one of these programs, your computer will be 
setup to render to RealAudio.

New tracks are picking up sound from old tracks.
Your new audio tracks are picking up remnants of other tracks.  Your microphone or 
input device is picking up the output from your speakers.  Try using headphones.  If 
that doesn’ t work, your soundcard may have some touchy circuitry.  Go to your mixer
’ s recording settings and make sure that only the devices you are interested in 
recording are set.

 Recording is not working!
You’ re mixing sounds great, but you can’ t record anything!!!  There can be many 
reasons why this is not working.

1. Your microphone is not plugged in to the right hole in the back of your 
soundcard.  Sometimes it happens. �

2. You’ re trying to record on your CD but nothing is happening.  Make sure that 
your soundcard has a connection to your CD player.  This is usually an internal 
cable.

3. Another problem for not recording is related to the Win95/98/NT audio mixer.
� Double click the speaker icon on the lower right of your Window’ s taskbar.
� Select "Properties" from the Options menu.
� Select "Adjust volume for recording" radio button.
� Make sure all the checkboxes are checked in the window entitled "Show 

the following volume controls" and press the "OK" button.
� Make sure that the device you are trying to record is selected and the slider 

is up.
� For example, if you are trying to record the CD,  make sure the checkbox 

enabled "Select" in the "CD Audio" panel is checked, then adjust the slider 
to about 75%.

� Make sure that the overall "Recording" balance on the very left is also set 
at 50%. (On many systems, you cannot adjust this anyhow.)

� Go back to MP3 Audio Mixer and start recording!

What are these CD Track Marker things?
Track markers can be used to help organize your session.  But they can also be 
used in conjunction with a multi-WAV save.  What’ s that you say?  Lets say you 
created this 60 minute CD audio masterpiece that has 10 sections.  You invite your 
friend over and tell him to "listen to this one part."  You spend 15 minutes trying to 
fast forward to the right spot and your friend loses interest!  Wouldn’ t it have been 
better to just seek to track #8 ,for example?  Thus, you can place a marker at the 
exact spot and select the "CD Track" checkbox.  When you do a multi-WAV save, it 
will create multiple WAV files based on these "CD Track" markers.  Then, use your 



cd burning software and drag in the new files!

How do I cut and paste portions of sounds?
You know how to copy a whole sound or sound Group.  But how do you copy part of 
a sound or Sound Group?  Left click on the session (not on a sound) .  Keep the left 
mouse button down and then move the mouse over the area you want to copy or 
cut.  A selection rectangle will highlight over the area of the sound or Sound Group.  
Then let the mouse button up and select "Cut" or "Copy" from the "Edit" menu.  If 
you are "copying", you can then select "Paste" from the "Edit" menu to paste at the 
caret point.

I can’t render to Realaudio™ files!  It’s grayed out!
Realaudio is now a separate download in some cases.  You can download the 
Realaudio plugin for MP3 Audio Mixer at http://www.acoustica.com/ 

Hey, I can’t even find my problem in this section!
Start your Internet browser and go to http://www.acoustica.com/support.htm for the 
latest help.  You will even find some animated tutorials on the most common 
problems!  If it’ s not on the website, you can request a support request from our 
online help form at to http://www.acoustica.com/support.htm !  


